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Chapter 3
UCS, Viewports and Wireframe Modeling

_ ™

Ojediives

¢ Understand the Use of UCS on More
Complex Designs

¢ Display and Orient 3D Views

¢ Apply and Expand the Basic Wireframe
Construction Techniques

¢ Use Additional Tools to Assist the
Creation of 3D Wireframe Models

¢ Use the Named Views Option
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Introduction

In the previous chapter, we examined some of the basic techniques to create 3D
wireframe models. Again, a wireframe model is a skeletal description of a 3D object.
There are no surfaces in a wireframe model; it consists only of points, lines, and curves
that describe the edges of the object.

In this chapter, we will further discuss the techniques and wireframe modeling tools
available in AutoCAD. Instead of creating the corners and edges of wireframe models by
entering the precise 3D coordinates, the use of construction lines and referencing
techniques are illustrated. The construction of edges in 3D space can be simplified by
using the AutoCAD User Coordinate System. We will also use the multiple viewports
option, which is available in most CAD systems, to aid the construction of 3D wireframe
models.

It is important to point out that most of the construction tools used in creating 2D designs,

such as Object Snap and Polar Tracking, as well as the Copy, Mirror, and Array
commands, are also applicable to the constructions of 3D wireframe models.

The V-Block Design
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Starting Up AutoCAD 2022

1.

Select the AutoCAD 2022 option on the Program menu or select the AutoCAD

2022 icon on the Desktop.

AutoCAD 2022 - English

MNew

L [ype here to search

»' . )
{ | Attach Digital Signatures

e
AutoCAD 2022 - English

n New 3

@ Batch Standards Checker

Export AutoCAD 2022 Settings

Import AutoCAD 2022 Settings

2. In the Startup window, select Start from Scratch.

3.
units.

o

In the Default Settings section, pick Imperial (feet and inches) as the drawing

4. Pick OK in the Startup dialog box to accept the selected settings.

3D Modeling Workspace

{553D Basics

v w
Drafting & Annotation odify| 1. Click on the workspaces list in the Quick Access
B — toolbar and choose to use the 3D Modeling
_ . workspace as shown.
3D Modelmgh (A
2. On your own, switch on the Menu Bar.
| Save Current 3D Modeling >
Workspace S . . .
P Press F1 for more help || > Notice the different 3D modeling toolbars
Customize.. I available in the Ribbon toolbar area as shown.
e
A- Do HE L T &< - {530 Modeling v|¥ 9 Share  Drawingldwg b |Type o keyword or phrase O, & Rshih va O- - 0OX
Home  Solid Surface Mesh Visualize Parametric Insert Annotate View Manage Output Add-ins Collaborate  Express Tools  Featured Apps =~
D -] PRePsd 05 - MNAEPTE- ,—m t,- 1 tr, 12 18 20 Wierame ~ i ﬁ; £Z | [m =
- h e A = 5 ; ! = | Eff [OJ
Box é;u/de L Smooth eosk & ® C I%i Section T?" Bzt UnsavedVlew - Culling| NoFilter — Move Layers = Groups View
M M Object @ (& & 08 - () 1 J ARl E®H- Plane - 18 world v [ Gizmo ™
Modeling ~ Mesh ¥ Solid Editing = Draw = Modify v Section = ¥ Coordinates View « Selection - - -

fart Drawinal X +
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Layers Setup
1. Inthe Menu Bar, sclect [Tools] 2> [Toolbars] > [AutoCAD] > [Layers].

Tools Draw  Dimension Modify  Window  Help  Parame 3D Navigation
Workspaces > Fe Output  Colla Array Edit
¢ Palettes > = fe . t Array_Toolbar
[ Toolbars > AutoCAD > CAD Standards
{! Command Line Ctrl+9 Section A Camera Adjustment
u Clean Screen Ctrl+0 Plane I Dimension
" %% Spelling ection ~ ¥ Co Dimensional Constraints
k= Quick Select.. s
Draw Order > Draw Order
Isolate 3 Draw Order, Annotation to Front
Inquiry 3 Find Text
lA:_-i‘ Update Fields Geometric Constraint
. Group
[ Block Editor Inquiry
Xref and Block In-place Editing > Insert
E‘E Data Extraction... Layers
Data Links > Lakrs M
& - 1 - i |
ss-—f@%.-,-._'_‘?lo . _ .
2. Click Layer Properties Manager in the
(-] Layer Properties Manager Layers toolbar.

% In AutoCAD, we always construct entities on a layer. It may be the default layer or a
layer that we create. Each layer has associated properties such as the visibility setting,
color, linetype, lineweight, and plot style.

‘:& == = 4 3. Click on the New Layer button. Notice a layer is
automatically added to the list of layers.

v New Layer (Alt+N)

4. Create two new layers with the following settings:

Layer Color Linetype Lineweight
Construction Grey Continuous  Default
Object Cyan Continuous 0.30mm

5. Highlight the layer Construction in the list of layers.

G G S 6. Click on the Set Current icon to set layer Construction
s N gg . . as the Current Layer.
ame
:| = 0 | Set Current |
’ﬁ} 7. Click on the Close button to accept the settings and
y¢§ Current layer: Const exit the Layer Properties Manager dialog box.
F3 B £g
Sl !& F;.Iters « 8. In the Status Bar area, turn ON the Grid Display, Polar
Tracking, Object Snap, Object Snap Tracking, Dynamic
B2 All Input and Lineweight options.
- C5 All Used
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Create the Rectangular Base of the Design

We will first use construction geometry to define the outer edges of the design.

“SEFY

2 © L g M Object

R 3 & U o’ Bl Construction 1. nthe Layer Control box,

confirm that layer

1 & & T of -
s LN |Constiuction Construction is set as the

Current Layer.

bols Draw Dimension I

rametric  Insert  Annotate
FD A T e & 4H
SO ®

210, '|:|x ORIy W

Rectangle

Creates a rectangular

2. Select the Rectangle icon in the Draw toolbar. In the
command prompt area, the message “Specify first corner
point or [Chamfer/Elevation/Fillet/ Thickness/ Width]:”
is displayed.

3. Place the first corner point of the rectangle near the
lower left corner of the screen. Do not be overly
concerned about the actual coordinates of the location;
the drawing space is as big as you can imagine.

4. We will create a 3" x 2" rectangle by entering the coordinates of the second corner
using the relative coordinates input method.
Specify other corner point or [Dimension]: @3,2 [ENTER].

TEE IEDWireframe - g
[EX |Unsa1.red"u"iew v_| c
- @Tap
Hl@Buttnm |
] Left
(o Right
"._jFrn:nnt
gBack

i3 SW Isometric
K‘tﬁ SE Isomgtric |

€ NEIsnrrJrESEI -
SOMELrC
€2 NW Isl:urr[

View Manager...

ele

5. Inthe View panel, select:
[Unsaved View] - [SE Isometric]

e Notice the orientation of the sketched 2D rectangle in
relation to the displayed AutoCAD user coordinate
system. By default, the 2D sketch-plane is aligned to
the XY plane of the world coordinate system.
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Create a Wireframe Box

Next, we will use the Copy command to define the 3D boundary of the design.

mension  Modify  Window

Annotate  View  Manage
R

B @& C Copy
A bl ¢ Copies objects 3
Modify :

1. Click on the Copy Object icon in the Modify toolbar.

2. In the command prompt area, the message “Select
objects:” is displayed. Pick any edge of the sketched
rectangle.

Inside the graphics window, right-click once to accept
the selection.

In the command prompt area, the message “Specify base point or displacement, or
[Multiple]: is displayed. Pick any corner of the sketched rectangle as a base point to

create the copy.

In the command prompt area, the message “Specify second point of displacement or
<use first point as displacement>:” is displayed.
Enter @0,0,2.25 [ENTER].

Note that the three values represent the distance measured in the X, Y and Z
directions relative to the current UCS.

e,

6.

WL

B |

I

v | Zoom Extents
Zoom Window
Zoom Previous

Zoom Realtime

Zoom All I::z?

=z ™

Use the Zoom All command, in the View Display toolbar, to
adjust the display.

On your own, use the Line command to create the four lines
connecting the four-corners of the two rectangles as shown.

pls

™
[

~J
(753

Draw Dimension Mod

Bmetric  Insert  Annotate
DA T o B

@ - @®C

Wi

A

| Line

Dr ; ;
Creates straiaht line seai




UCS, Viewports and Wireframe Modeling 3-7

Using the View and UCS Toolbars

1. Inthe Menu Bar, select [Tools] = [Toolbars] = [AutoCAD].
Tools Draw  Dimension  Modify Window  Help  Param
Workspaces >
Palettes > Ik [
Toolbars > AutocAly >
| Command Line Cirl+9 Move Offset Cop
Clean Screen Ctrl+0 .
| ¥.]
ucs
ucsii . . . .
v 2. Select View, with the left-mouse-button, to display the View
1w % toolbar on the screen.
Viewports
Visual Styles
Walk and Flv
Text 3. Move the cursor to the Standard toolbar area and right-click
ucs on any icon of the Standard toolbar to display a list of toolbar
ucs i menu groups.
| View 4. Select UCS I, with the left-mouse-button, to display the
LLETLINE UCSII toolbar on the screen.
» The options available in UCS II toolbar allow us to quickly align the UCS to the
preset standard 2D views.
R - WE N
i, 19|18 word 5. Note that the current UCS is aligned to the
T% World World Coordinate System. Select Front in
b ?re‘”ous the UCS II toolbar as shown.
op
@ Bottom
(Ao |
g Back
7 Left
E’E Rnght [-1ISE ometric]I2D Wireframe] -
> Note that the UCS has been . A ~_ | . -
adjusted and it is now aligned | I N
parallel to the front view of the : : NN
wireframe box as shown in the ' S ~NO
figure. g
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Create Construction Lines in the Front View

Is Draw Dimension Mo

kmetric Insert  Annotate i
DL T -th AP
NAO- B ®C

(ON
~ ] Line

= Temporary track point

—

b From
Mid @e‘rween 2 Points
Point Filters b
3D Osnap >

Restrict cursor to specified
Polar Tracking (F10)

b G Y - [~ 3

3, 1T, I3, &0

Trackjr\q\Settings... N
L [G]- Y [£]E - |

A Drafting Settings

Snap and Grid Polar Tracking Objd

[«] Polar Tracking On (F10)
Paolar Angle Settings

Increment angle:

El ]

g

1.

Select the Line command icon in the Draw toolbar. In
the command prompt area, the message “ line Specify
first point.” is displayed.

2. Inside the graphics window, hold down the [SHIFT]
key and right-click once to bring up the Object Snap
shortcut menu.

3. Select the From option in the pop-up window.

4. Pick the lower right corner of the bottom horizontal
line in the front view as the base point.

5. In the command prompt area, the message “Specify
next point or [Undo]:” is displayed. Enter @0,0.75
[ENTER].

6. We will set up the Polar Tracking option to assist the
creation of the next corner. Right-click once on the
POLAR Tracking option located at the bottom of the
graphics window.

7. In the option menu, select Settings by clicking once
with the left-mouse-button.

8. Inthe Drafting Settings dialog box, set the Polar
Increment Angle setting to 30 degrees.

A Drafting Settings

[.] Ohiect Snan On (F3)

9. Click on the Object Snap tab to switch to

Snap and Grid Polar Tracking Obieﬁsﬂap 30 the Object Snap option settings.
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A Drafting Settings

[¥] Object Snap On (F3)
Object Snap modes

1 [“]Endpoint
[IMidpaint

[~ Center

[] Geometric Center
[INode

[JQuadrant

X o’ ook

InLeL{)ection

Snap and Grid Polar Tracking ObjectSnap 3D ObjectSnap Dynamic In

> H M AOF F

Object Snap Tracking

[~ Extension
[linsertion

[ Perpendicular
[ Tangent
[INearest

DApparentmtersectlon

CParallel

r:

a Ta Snaps to the intersection of an object such as an a
5 2 line, polyline, ray, region, spline, or xline. Extended
not available 35 3 nunning obiect snan

13. Move the cursor near the left vertical
edge of the front view and create the
second line perpendicular to the last

line we created.

14. Inside the graphics window, right-
click to activate the option menu and
select Enter with the left-mouse-
button to end the Line command.

10. Confirm that the Intersection and
Extension options are switched ON as
shown.

11. Click on the OK button to accept the
settings.

o0

12. In the command prompt area, the
message “Specify next point or [Undo]:”
is displayed. Using the Polar Tracking
option (30 degrees increment), create a
line as shown in the figure.

Enter
Cance[l}

Recent Input
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Copy Objects in the Negative Z Direction

mension  Modify  Window |1 Click on the Copy Object icon in the Modify toolbar.
Annotate  View  Manage

e & Y- -+ 2. Inthe commgnd prompt area, the message “Se]ect
b ® C objects:” is displayed. Pick the two edges we just
= Copy created.

< ARG

Copies objects| . . . . .
Modify : g 3. Inside the graphics window, right-click once to accept

the selection.

4. In the command prompt area, the message “Specify base point or displacement, or
[Multiple]:” is displayed. Pick any corner of the wireframe model to use as a base
point to create the copy.

5. In the command prompt area, the message “Specify second point of displacement or
<use first point as displacement>:" is displayed.

Enter @0,0,-2.0 [ENTER].

6. Note that the negative value represents the distance measured in the negative Z
direction relative to the current UCS.

7. On your own, create three lines to connect the corners of the two sets of lines we just
created, as shown below.

[—1ISE Isometric ][ 2D Wireframe] T T,
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Create an Inclined Line at the Base of the Model

it 18 | 7 Top ~ X[ 1. Select Top in the UCS II toolbar as shown.

s Draw  Dimension Mo 2. Select the Line command icon in the Draw toolbar. In

e R haalate Y the command prompt area, the message “ line Specify

DA T AP first point.” is displayed.
NIZ O @
P 5 ®C 3. Inside the graphics window, hold down the [SHIFT] key

S e and right-click once to bring up the Object Snap
shortcut menu.

= Temporary track point
-
b Fr-::-m@e

M'_d _tween 2 Points 4. Select the From option in the pop-up window.

Point Filters >

3D Osnap >

_ ' _ 7| 5. Pick the lower right corner of the bottom horizontal line
5 _ e as the base point as shown in the figure.
>E _ ' 6. We will place the first point above the selected corner.
Enter @0,0.75 [ENTER].

7. In the command prompt area, the message “Specify next
point or [Undo]:” is displayed. Using the Polar Tracking
option (30 degrees increment), create a line as shown in
the figure.

[-1ISE Isometric ]| 2D Wireframe] iy el

8. Inside the graphics window, right- T A N
click to activate the option menu : ol A g
and select Enter with the left- N e
mouse-button to end the Line ' ]
command. I

Enter : : SR N
% . LT . . . .\‘.' . ;)(\ .
Cance . N . v T T

Recent Input
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» On your own, use the Copy and Line commands to create additional edges so that the
wireframe model appears as shown below.

[-]ISE sometric ]|2D Wireframe] f;"’“mm
- ",
. __.-"'""’F-' KHH.‘“‘\-\
-
,-"-'/H Hw\"m
- "
<"?f M*‘H}
o —
-, e TN
%H“h . .-'"'?-__ .-f’f/ ""-. H"“n
"'\-\.‘HH ’_-__‘.-' .__‘__,.-* I".| “"m:,
-
:}{:»., ’-_H.-"" . .‘.,l!?’_-/.-"'f
- ., -~
____.f"":-d H"‘AH (__‘__,/"F-' ____.--"f \".,
- — 1 -~ Y
- e —— . R
e ____.---\.,‘_\::"-_:-\-\-\-L -w.\_:—___ - =] ‘I".
__,.-"" u"-‘."m "'\-\.‘_\__J.-"'-‘ "'\._‘
- T
. ,__.-*"' .'.llll H‘H‘m "".\
. L1
___,,-"":-J ! H"\.H h
- L1 e =1
‘:.-"'-"-' II'-.\ ) ™ H""‘h /.--/___,.-'
HMH""-\.H‘ '\."" . __,-‘:}{m
e \ -~ L,
H‘HH '\-‘ ’_.-" H‘m}
. -
z h‘x\% 'l._‘if___,.-' /’__H_.-'
Y ) HH‘H .-"'ﬁ/’a
"\-\.H -~
e . — -~
x - ':__ _______,-'_""
’ HH“"\-\..-"'"
Create Object Lines
© 25| @ @ L] o W construction 1. On the Object Properties toolbar, choose
@9 i lO the Layer Control box with the left-mouse-

-1l & ¥

2 u' [l Construction button.
o'l

2. Move the cursor over the name of layer
Object; the tool tip “Object” appears.

Object

3. Left-click once on the layer name; now layer Object is set as the Current Layer.

bls Draw Dimension Moaodq
ametric  Insert  Annotate V|
Y =R o R N 4. Select the Line command icon in the Draw toolbar. In

N P the command prompt area, the message “ line Specify
MNA OB ®C first point:” is displayed.

Line

Creates straiaht line seqi




UCS, Viewports and Wireframe Modeling ~ 3-13

5. Pick the lower left corner of the bottom of the wireframe model as the starting point
and create the four line segments as shown.

[—1I5E Isometric J|2D Wireframe]

Fifth point \

First point N

X - | Second point

¢ Note that even though the UCS is aligned to the base plane of the model, the Object
Snap option enables us to select points on the front plane of the model.

» On your own, create three additional lines representing the edges of the inclined face
of the design as shown.

[—1ISE Isometric ]| 2D Wireframe] - T~
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Multiple Viewports
View Insert Format Tools Draw  Dimension Modify  Wind
o rediaw wrt Amotate  View Mand 1. Inthe Menu Bar, select:
|| Regen T AP BY-
. T5 Regen Al b . le @ S [View] 2 [Viewports] >
I sl e B [4 Viewports]
Zoom b AF €88 - P
Pan >
. - Modify « .
@) steeringWheels > AutoCAD allows us to display
> ShowMotion = different VIEWS of the model
Orbit > EEE .
= oo g simultaneously. Only one
Walk and Fly > viewport is activated at one
T — R time. The viewport w1th the
Viewports B 52, Named Viewports. dgrker border is the active
R Named Views _ viewport. Move the cursor
L\ New Viewports... .. .
3D Views > : inside each viewport and
1 Viewport R .
(@] Create Camera L notice the different cursor-
Show Annotative Objects > 3 Viewports dlsplay inside the active
® Hide 4 Vieworts viewport.
Viicinl Sl & Polygonal Viewport

BN E B

Top

Sets the view point to top

=% VIEW

2. Activate the top left viewport by left-clicking once

inside the viewport.

3. Select the Top view in the View toolbar to change

the display of the viewport.

4. On your own, repeat the above steps and use the Realtime Zoom command to set
and adjust the displays of the viewports as shown below.

I [ +11SE someétric ]| 20 Wireframe] ;_/,.- —
r/’ .

\

» Note that the displayed UCS icons at the lower left corner of each viewport
correspond to the orientation of the wireframe model in each viewport.
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Use the Mirror Command

1. Activate the top left viewport by left-clicking once inside the viewport.

2. Pre-select all the objects in the active viewport by using a selection window.

[+1TopH2D Wireframe] -

First corner /

‘ Second corner
@/

Inside the active viewport, right-click to bring up the pop-
up option menu and select the Quick Select option.

Y
X
Subobject Selection Filt
Quick Select... 3.
QuickdBic
(E\ | T |
A Quick Select

Applyto: |Currentselection

Objecttype: |Multiple

Properties: [Cglor

Layer

Linetype
Linetype scale
Plot style
Lineweight
Transparency
Hyperlink

Operator: |=Equals

Value: |§Object

How to apply: bs

© Include in new selection set

(O Exclude from new selection set

[JAppend to current selection set

Help

In the Quick Select dialog box, select
Layer from the Properties list.

Set the Value box to Object.
In the How to apply section, confirm the

Include in new selection set option
is selected.

Switch OFF the Append to current
selection set.

Click on the OK button to accept the
settings.

AutoCAD will now filter out objects
that are not on layer Object.
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Annotate  View Manage  Output

NI IRt S A f@ 1 9. Click on the Mirror icon in the Modify toolbar.

B ®C D e ] : o
s A Ee®-| pame |1 10. Inside the graphics window, hold down the [SHIFT]
o key and right-click once to bring up the Object

Section v
Snap shortcut menu.
B8 9 8 4
E B ] e o . . . .
b = D eror 11. Select the Midpoint option in the pop-up window.
iGN N :
Y Creates a mirrored

1 Modify D/j Endpoint

7 Midpgint
[+1Tepll2D Wireframe] >< Interséttion

\< Apparent Intersect

12. Inside the active viewport, click on the left vertical line
of the wireframe model. With the Midpoint snap option,
the midpoint of the line is selected.

13. Move the cursor toward the
right vertical line in the active
viewport; left-click once when
the Intersection symbol is
displayed as shown.

14. In the command prompt area, the
message “Delete Source Objects?
[Yes/No] <N>:"is displayed.
Inside the graphics window, right-
click once to bring up the option
menu and select No to keep both
sets of objects.
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Turn Off the Construction Lines

1.

On the Object Properties toolbar, choose the Layer Control box with the left-mouse-

button.

20 g H Object

@ Lyni' MO

&% [ o m e
[ ! T_f O~ -

Turn a layer On or Off

View Insert Format Tools Dimension  Modify
| " Redraw sert  Annotate  View
1 - 0%
[ Regen s
L 5 Regen All S P
lté = [[:J ‘,@;’ 6 D—*_'-

Zoom .
b - ¢ AR E
Pan et

IZ@ SteeringWheels : odify ~
BF  showMotion
| Orbit 7 %

; Camera
Walk and Fly
Clean Screen \
Viewports EI%I Named Viewports...
= Naméd\flews... 1 New Viewports...
3D Views 1 Vigwport
(@) Create Camera 2 Viewports
Show Annotative Objects 3 Viewports

2. Move the cursor over the light-bulb icon for
layer Construction, left-click once, and notice the
icon color is changed to a gray tone color,
representing the layer (layer Construction) is
turned OFF.

In the Menu Bar, select:

[View] = [Viewports] 2>
[1 Viewport]

Viewports can also be used as a
way of checking the integrity of
the constructed 3D models. Feel
free to switch to multiple
viewports in the following
sections of this tutorial.

On your own, create the
additional object lines
connecting the two sets of objects
as shown below.




3-18  AutoCAD 2022 Tutorial: 3D Modeling

Create a New UCS

» The V-cut feature of the

design is the last feature, and
perhaps the most difficult one,
to create in the CAD system.
Based on your knowledge of
modeling with AutoCAD,
how would you create this
feature? What are the more
difficult aspects of creating
this feature?

Besides using the preset UCS planes, AutoCAD also allows us to change our viewpoint
and create new UCS planes. We will create a UCS plane aligning to the inclined plane of

the design.

Display Image > I I
New UCS > 1® World
1E Named UCS.. 1% Previous

@ Geographic Location... Tﬁ', Face
CAD Standards > 19, Object
Wizards > 10 view

¥, Drafting Settings.. fx, Origin

5] Group tz, Z Axs Vector

.

8% Ungroup TE, 3 Point
Tablet 2

toex

A

-

Intersection

1.

In the Menu Bar, select:
[Tools] > [New UCS] >
[3 Point].

Note that other options are also
available to aid in the creation
of new UCS planes.

2. In the command prompt area, the message
“Specify New Origin point <0,0,0>:” is
displayed. Pick the lower-left corner of the
inclined plane as shown.
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|

Intersection

4. In the command prompt area, the
message “Specify point on positive
portion of X-axis:” is displayed. Pick the
top left corner of the inclined plane as

In the command prompt area, the message
“Specify point on positive portion of X-axis:”
is displayed. Pick the lower right corner of
the inclined plane as shown.

shown.
>
Pl
> UGS Icon > B+ on 5. Inthe Menu Bar, select
ViewCube > v Origin
Attribute Display > @' Pmpﬁrties_ [VIeW] > [Dlsplay] >
(@] Cameras "" [UCS Icon] = [Properties]
£ Lights
E| Navigation Bar
=] Text Window Ctrl+F2 A UCS Icon
\ e
UCS icon style
6. Inthe UCS Icon window, switch the UCS icon style to @20
2D as shown. %
O3 Line widil

7. Click on the OK button to
accept the settings.
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Create a New Named View

Besides using the preset views, AutoCAD also allows us to change our viewpoint and
create new views, which can be saved and restored by name for convenient access. We
will create a new view aligned to the new UCS plane we just created.

1. Inthe Menu Bar, select
[View] - [3D Views] -2 [Plan View] - [Current UCS].

Viewpaorts >
I Named Views... /\
3D Views > 1% Viewpoint Presets...
(@] Create Camera Tﬁ Viewpoint
Show Annotative Objects > Plan View > [E Current UCS
_ 2!
@ Hide @ Top -E Worla UCS
Visual Styles > (& Bottom = Named UGS
Render > Q Left

e The graphics window is now adjusted to display the current UCS plane.

I«_%%@ i 0 (4| 2. Click on the Named Views

icon in the View toolbar.

X ) ) Named Views...

3. Inthe View dialog box, click on the New button to
create a new named view.

Set Current

[ e |
Lz

Update Layers

A New View / Shot Properties

4. Inthe New View dialog box, enter

View name: |‘°‘“’“'”a'71 Auxiliary as the new View name and
confirm the Current display option. In
the View Properties list, set the Save
View type: still layer Snapshot with view option to
ON and the UCS option as Unnamed.

View category: |<:N|:|ne>

Boundary

(@) current display
() pefine window

I 5. Click on the OK button to accept the
settings and create the named view.
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6. In the View dialog box, the new named view (Auxiliary) is added to the Named Views
list. Note that we can always switch to this view by using the Set Current option.

A View Manager

Current View: Current
Views

o Q Current

BE& Model Views
¢ Ll Auxiliary
Layout Views

&-{7]) Preset Views

General
Name Auxiliary
Category <MNonex>
ucs Unnamed

Layer snapshot Yes

Annotation s... 1:1

Visual Style 2D Wireframe

Background... <MNone:=

Live Section <None>
Animation

View type St

Cancel

X

- Set Current
—

Mew...
Update Layers
Edit Boundaries...

Delete

Apply Help

7. Click on the OK button to accept the settings.

|
BOPEHIDB OGS O«

SE Isometric

8. 1In the View toolbar, select SE
Isometric View.
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Create the V-Cut Feature on the Inclined Plane

1. On your own, create two lines that are 0.2"” away from the top corners of the model,
which are also rotated 45 degrees relative to the top edge of the model.

6. Second Point

——

a

5. Base Point

mension  Modify  Window

Annotate  View  Manage

A DY

A r-\_J l/-f

R

£ ARl Copies objects
Modify

Click on the Copy Object icon in the Modify toolbar.

In the command prompt area, the message “Select
objects:” is displayed. Pick the two inclined lines we
just created.

Inside the graphics window, right-click once to accept
the selections.

5. In the command prompt area, the message “Specify base point or displacement, or
[Multiple]: is displayed. Pick the top left corner as the base point to create the

copy.

6. In the command prompt area, the message
“Specify second point of displacement or
<use first point as displacement>:" is
displayed. Pick the corresponding corner
on the backside of the model as shown in
the above figure.

7. On your own, create addition lines to
define the edges of the V-cut and use the
Trim command to complete the model as
shown.
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BOPEORBO

Front

8.

Click on the Front View icon in the View
toolbar.

hd

» Note that the V-cut we
created, using the Copy
command, does not represent
a cut that passes through the
entire block.

.

Extend the Cut and GRIP Editing

e &4 Y-

/ALl E

mension  Maodify  Window  Help
Annotate  View Manage QOutpy

l"——’ [:@:j C) D:— _%;Trim Jcm

Modify + _—"‘ end v
Extend

=]

e

1.

Select the Extend command icon in the Modify
toolbar.

2. The message “Select object to Extend or [Project/ Edge/ Undo]:” is displayed in the
command prompt area. Pick the bottom edge of the V-cut to extend.

Boundary
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3. Inside the graphics window, right-click to activate the option menu and select Enter
with the left-mouse-button to end the Extend command.

el =i il ) é& € @ @ |@| 4. Click on the SW Isometric View

icon to reset the display to the preset
SW Isometric 1sometric view.

5. Pre-select the top edge of the V-block as shown.

6. Left-click once on the lower right grip point on the
selected line.

e Selecting the grip points located at the end of the line or
arc allows us to STRETCH the selected line.

7. Move the cursor toward and select the lower corner of
the V-cut as shown.

» On your own, repeat the above steps and use the grip
editing options and complete the wireframe model as

Endpoint
£ shown below.

/- ﬁ\
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Review Questions:

1. List and describe three different types of 3D computer geometric modeling software
available today.

2. What is a Named View?

3. What is the difference between Stretch and Extend?

4. List and describe the methods available in AutoCAD to create a new UCS plane.
5. What is the difference between Copy and Mirror in AutoCAD?

6. Identify and describe the following commands:

a)

i
b)
c)

—
d)

Ab
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Exercises: (Unless otherwise specified, dimensions are in inches.)

1.

473

6,50
~—130 3,50
100 — 100
4,00
1.00—
173
273
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